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Jak nainstalovat fryrender 
standalone a pluginy 

INSTALACE PRODUKTU 

 

 

instalační dialog fryrenderu 

Aplikace fryrender existuje ve dvou insta-
lacích: jedna pro 32bitovou verzi a druhá pro  
64bitovou. Když instalujete fryrender, na-
kopíruje instalátor samostatně spustitelnou 
aplikaci, pluginy a související dokumentaci do 
adresářové cesty Destination folder podle 
instalačního dialogu. Standardně je to cesta 
c:\feversoft\fryrender. 

Proces instalace je jednoduchý: po zadání 
složky Destination folder kliknete na tlačítko 
Install a počkáte, až se instalace dokončí. 
Pokud by se vyskytly nějaké chyby, budou 
vypsány v dolním poli s názvem Errors Log.  

Po úspěšném dokončení instalace zavřete 
instalační dialogové okno. 

Když je aplikace nainstalována, objeví se v 
seznamu programů Windows nový záznam  
Feversoft. Obsahuje podmenu FRYRENDER 
(32/64-bit) s dokumentačními soubory a se 
zkratkami pro samostatně spustitelnou ap-
likaci a pro odinstalaci Feversoft fryrenderu z 
vašeho systému. 

INSTALACE FRYRENDERU 

 1 
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Zvolte cílovou složku. Pro volbu jiné složky klikněte 
na tlačítko procházení vpravo od adresářové cesty.  

Instalaci zahájíte kliknutím na tlačítko Install. 

 1 
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INSTALACE PLUGINŮ 

Po nainstalování samostatně spustitelné aplikace je dalším krokem instalace příslušného pluginu pro vaši 3D 
aplikaci. Všechny pluginy pro podporované hostitelské aplikace jsou součástí instalace fryrenderu, ale mějte 
na paměti, že 32bitový instalátor obsahuje pluginy pouze pro 32bitové aplikace (nebo pro  32bitovou verzi 
aplikace, která se dodává v  32 i 64bitové verzi).  To samé platí i pro 64bitový instalátor.  

Nyní vám poskytneme stručný návod pro instalaci pluginů do jednotlivých hostitelských 3D programů. Další 
informace najdete na webové stránce fryrenderu v sekci Frequently Asked Questions. 

 

3DStudio MAX / VIZ 

Stačí zkopírovat fry_max.dlr, umístěný ve složce Feversoft/fryrender/plugins##/fry_max do vaší složky 
3dsmax/plugins a spustit 3DStudio MAX. fryrender by se měl objevit jako nový renderer.  

 

 

Cinema 4D 

Zkopírujte složku fry_c4d do složky pluginů v C4D, musíte přitom zachovat tuto strukturu složek: 

 /plugins/fry_c4d 

 /plugins/fry_c4d/res  

 

 



  

Feversoft fryrender :: rychý start 

3 

Lightwave 

Zkopírujte soubor fry_lw.p do známé složky (obvykle složka pluginů Lightwave, kterou byste měli najít na  
C:\Program Files\NewTek\LightWave 3D 9.?\Plugins nebo v podobné cestě). 

 

Poté spusťte aplikaci Lightwave Layout a přepněte si záložku Utilities. Klikněte na tlačítko Add Plugins, vyhle-
dejte soubor fry_lw.p file a otevřete ho. Měl by se objevit dialog, který vás informuje o že byl úspěšně přidán 
určitý počet pluginů, který koresponduje se součástmi fry_lw.  

 

 

Rhinoceros 

Soubor fry_rhino.rhp nakopírujte do známé složky (obvykle je to adresář Rhina, který by měl být umístěný v 
C:\Program Files\Rhinoceros 4.0\Plug-ins nebo v podobné cestě). 

 
Poté spusťte Rhinoceros a v menu zvolte Nástroje > Volby (Tools > Options). Zvolte panel Zásuvné moduly 
(Plug-ins), klikněte na Instalovat (Install) a vyhledejte soubor fry_rhino.rhp. Po úspěšném nahrání by se měl 
plugin zobrazit v seznamu pod názvem Feversoft FRYRENDER. Nyní je fryrender v Rhinu nainstalován. 
Nezapomeňte jej nastavit jako aktivní - Render > Aktivní renderovací modul (Render > Current Renderer).  

 

 

Maya 

Soubor fry_maya.mll zkopírujte z příslušného zdrojového umístění, podle toho, zda používáte Mayu 8.0 
nebo Mayu 8.5, do známé složky (obvykle složka pluginů Mayi, kterou byste měli najít pod cestou 
C:\Program Files\Autodesk\Maya8.?\bin\plug-ins nebo v podobném umístění). 

Poté spusťte Mayu a v menu zvolte položku Window > Settings/Preferences > Plugin Manager. Klikněte na 
tlačítko Browse a vyhledejte soubor fry_rhino.mll. Po nainstalování zatrhněte volbu Auto Load, aby se plugin 
nahrál automaticky při každém spuštění Mayi. 

Jakmile je plugin nahrán, zobrazí se fryrender jako nový typ rendereru. Musíte jej vidět v menu Render > 
Render Using.  

 

 

SketchUp 

Pro instalaci odpovídajícího pluginu (najdete jej v fry_su/su_5 nebo fry_su/su_6, podle toho, kterou verzi 
používáte), proveďte následující: 

Zkopírujte soubor s názvem fry_su.dll do /Exporters 

Zkopírujte oba soubory fry_su_loader_SU#.rbs a Win32API.so do /plugins  

Spusťte SketchUp PRO. Pokud bylo vše nastaveno správně, měla by se v menu Plugins objevit nová 
položka FRYRENDER. 

fry_su je integrován do SketchUp jako exportér. Pro vyrenderování scény s fryrenderem použijte menu File > 
Export > 3DModel a poté jako koncovku zvolte Feversoft FRYRENDER (*.fry). Ve specifikovaném umístění 
bude vytvořena výsledná scéna fryrenderu. Doporučujeme, abyste si pro soubory *.fry vytvořili samostatnou 
složku, místo toho, abyste je ukládali například do \My Documents\. Díky tomu budou všechny soubory, 
které patří k dané scéně, ukládány společně do této složky.  

 

 

Softimage | XSI 

Plugin je distribuován jako balík souboru XSI addon. Pro jeho instalaci spusťte XSI a v menu zvolte položku 
File > Addon > Install, vyhledejte soubor fry_xsi.xsiaddon a nainstalujte jej. Až budete hotovi, měl by se v 
Plugin Manageru objevit FRYRENDER Workspace a fryrender by měl být dostupný jako nový renderer.  
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Jak již bylo zmíněno, každá licence jedinečně identifikuje zákazníka a jeho “master” počítač. Každá licence ale 
může odemknout několik dalších počítačů v rámci stejné lokální sítě (LAN). Aby to mohlo být provedeno, 
musí být počítač s licenčním souborem (Master) zapnutý a musí na něm běžet fryrender. Master musí být 
viditelný ostatními počítači v LAN, věnujte proto prosím zvláštní pozornost nastavení firewallu a antivirových 
programů, které by v této komunikaci mohly bránit.  

Úvod do uživatelského roz-
hraní fryrenderu 

ÚVOD DO ROZHRANÍ 

Tato kapitola vám poskytne rychlý přehled uživatelského rozhraní fryrenderu. Nejprve si popíšeme hlavní 
moduly a poté budeme každý z nich analyzovat samostatně společně se stručným popisem jeho vlastností. 

 1 

 2 

3 

 

Po instalaci fryrenderu 
musíte projít procesem 
aktivace, abyste získali plat-
nou licenci. 

AKTIVACE PRODUKTU 

Pro odemknutí svého software budete potře-
bovat licenční soubor. Když koupíte fryren-
der, budou vámi poskytnuté informace zareg-
istrovány jako váš zákaznický profil. Pokud 
chcete získat licenci, potřebujete znát Activa-
tion Code, jehož umístění vidíte na vedlejším 
obrázku a tento kód pošlete se svým 
zákaznickým License ID do Feversoftu na 
adresu info@feversoft.com. Zašleme vám 
zpět e-mail se souborem license.ini. Tento 
soubor je jedinečný, pouze pro váš počítač.  

Pro instalaci licence nakopírujte tento soubor 
do složky se souborem fryrender.exe, ve 
složce tools32 nebo tools64 v instalační 
složce fryrenderu. Poté spusťte fryrender 
standalone a klikněte na tlačítko License aby-
ste se přesvědčili, že je licence aktivní.  

Spusťte fryrender a klikněte na tlačítko License v horní části 
okna. Na adresu info@feversoft.com odešlete Activation Code 

společně se svými zákaznickými údaji. 
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 VLASTNOSTI SCÉNY 

 5 
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NASTAVENÍ RENDERU 

Tento panel umožňuje nastavit proces renderování. Můžete zde na-
konfigurovat jádro použité pro renderování, výstupní rozlišení obrázku 
a počet jeho kanálů. 

1. START / RESUME / FORCE / STOP: tato tlačítka spouští a zastavují ren-
derování. Start provede čisté spuštění a vymaže přitom předchozí 
obsah framebufferu. Renderování můžete zastavit tlačítkem Stop. 
Tlačítko Resume má podobnou funkci jako Start, ale nevymaže 
předchozí obrázek, takže nové vzorky budou přidány k již existu-
jícím (čili budete pokračovat ve výpočtu předchozí scény). Během 
renderování obrázku fryrender automaticky ukládá obrázek na 
pevný disk zhruba každou půlhodinu. Uložení můžete kdykoliv 
vynutit tlačítkem Force.  

2. RENDER LOG: fryrender zde vypisuje svá hlášení. 

3. OUTPUT CONFIGURATION: konfigurace počtu renderovaných obrázků, 
velikosti výsledného obrázku a adresářové cesty pro uložení výsled-
ného obrázku. 

4. RENDER CONFIGURATION: umožní specifikovat počet renderovacích 
vláken CPU (který by měl pokud možno souhlasit s počtem jader ve 
vašem systému), jádro použité pro renderování obrázku a kanály, 
které budou tímto jádrem generovány. 

V těchto záložkách můžete 
konfigurovat veškeré ele-
menty, které tvoří součást 
scény a můžete je zde vy-
ladit je ještě před spuštěním 
renderu. 

1. HLAVNÍ PALETA. Tato horizontální paleta s ikonami umožňuje nahrání scény do správce renderu, volbu prior-
ity výpočtu, barevného schématu uživatelského rozhraní a správu licencí. 

2. VLASTNOSTI SCÉNY. Tato sada záložek obsahuje konfigurační panely pro každý ze stavebních kamenů scény: 
vlastnosti renderu, vlastnosti objektů, nastavení kamery, vlastnosti okolního prostředí a materiály. 

3. PRACOVNÍ OBLAST. Záložky v pracovní oblasti vám umožní konfigurovat tonální mapování obrázku, nastavit 
způsob kombinování zářičů pomocí funkce Layer Blending, použít realtime pohled pro zobrazení scény a také 
ovládat distribuovaný síťový rendering. 

 HLAVNÍ PALETA 

 1  2  3  4  5  6  7 

1. Nahrání skriptu scény. 

2. Uložení skriptu scény. 

3. Archivace celé scény. Když archivujete scénu, budou 
veškeré její zdroje sbalené do jednoho .ZIP souboru. To je 
velice užitečné pro přenos nebo zálohování scén. 

4. Změna priority procesu. fryrender je aplika-
ce s vysokými nároky na CPU, pokud jej tedy 
budete provozovat na pozadí, zlepší se odezva 
ostatních aplikací, které budou spuštěné v 
průběhu renderování obrázku. 

5. Změna barevného schématu uživatelského rozhraní. 

6. Licenční informace. 

7. Dialogové okno About. 

Hlavní paleta je vstupní 
branou aplikace fryrender 
standalone. Pomocí jejích 
tlačítek můžete nahrát 
scénu a nakonfigurovat 
editor. 
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NASTAVENÍ OBJEKTU 

Tato nastavení vám dávají další kontrolu nad zobrazením objektů v 
realtime okně a umožňují vám označovat objekty různými tagy, které 
upravují způsob jejich renderování.  

 

1. SCENE OBJECTS: objekty na scéně můžete vybírat pomocí tohoto 
seznamu. Pokud používáte realtime pohled v pracovní oblasti, bu-
dou v něm vybrané objekty zvýrazněny.  

2. SELECTED OBJECT: toto okno zobrazuje informace o vybraném ob-
jektu: počet materiálů (nm), počet trojúhelníků (nt), počet vrcholů  
(nv), název objektu a přiřazený materiál. 

3. OBJECT PROPERTIES: konfigurace nastavení vizualizace v realtime poh-
ledu a dále nastavení vrstvy, které je tento objekt přiřazen (používá 
se pro Layer Blending) a zdrojového objektu pro instancing, pokud 
je tento objekt instancí. 

4. OBJECT FLAGS: objekt může být označen návěstími, která řeknou ren-
derovacímu jádru, aby s ním provedl určitou speciální akci. Tato 
návěstí se používají pro vyloučení objektu z generování či přijímání 
určitých světelných komponent nebo pro označení objektu jako 
dynamického pro animace, exportované z pluginů v inkrementálním 
režimu. 

5. KERNEL CONFIGURATION: v této záložce najdete dodatečné parametry pro konfiguraci použitého jádra. 
Typickým parametrem patří kritérium ukončení renderu. Může jím být dosažený čas nebo počet 
průchodů. Druhé kritérium zajistí uniformní distribuci šumu ve více snímcích stejné scény, protože čas, 
potřebný k dosažení stejné míry šumu, se může lišit podle složitosti daného snímku. 

NASTAVENÍ MATERIÁLU 

 3 

 2 

Materiály jsou základní součástí popisu scény. Značná míra reality vaší 
scény bude záležet právě na tom, jakou péči věnujete tvorbě svých 
materiálů. 

 

1. OPEN MATERIAL EDITOR: toto tlačítko otevře Material Editor pro vy-
braný materiál. 

2. SCENE MATERIALS: seznam všech materiálů, které se nachází ve 
scéně. Materiál můžete editovat tak, že na něj poklepete myší nebo 
jej vyberete a kliknete na tlačítko Open Material Editor. 

3. MATERIAL PREVIEW: náhled materiálu.  

 1 
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NASTAVENÍ KAMERY 

 4 

 1 

 2 

 3 

Kamery určují, jaká část scény bude zachycena na snímku a jak bude 
shromažďováno světlo. V této záložce jsou vypsány všechny kamery na 
scéně a detailní informace pro každou z nich. 

 

1. SCENE CAMERAS: seznam všech kamer, které se nachází na scéně. 
Kamera, která je zde vybraná, bude použita v realtime pohledu a 
budou na ni mít vliv operace Hold/Fetch.  

2. CAMERA PROPERTIES: zde je uveden název kamery, poloha ve scéně a 
orientace pomocí vektorů Direction (vpřed) a Strafe (vpravo). 

3. CAMERA OPTICS: veškeré parametry, které se týkají simulace optiky 
kamery. Jedná se o fotografické parametry, které přesně souhlasí s 
parametry skutečné zrcadlovky. 

4. CAMERA EXPOSURE: podobně jako Camera Optics obsahuje oddíl 
Camera Exposure další fotografické parametry, které vám umožní 
řídit množství světla, které dopadne na virtuální film a také citlivost 
tohoto filmu. Můžete zde také povolit nebo zakázat rozostření po-
hybem (motion blur). 

 4 

 1 

 2 

 3 

NASTAVENÍ OKOLNÍHO PROSTŘEDÍ 

Okolní prostředí (Environment) je světlo, které přichází z oblohy a 
kopule kolem scény. V této záložce můžete upravit parametry fyzikální 
oblohy (Physical Sky) nebo zde můžete nahrát mapu (obrázek) pro 
umístění do pozadí nebo osvětlení scény.  

 

1. PHYSICAL SKY: povolí nebo zakáže osvětlovací systém Physical Sky 
prostřednictvím zatrhávacího tlačítka Use. Osvětlení lze konfigu-
rovat po kliknutí na tlačítko Configure Atmosphere.  

2. ENVIRONMENT MAPPING: zde nahrajete obrázek nebo nastavíte jedno-
litou barvu, která se použije pro osvětlení scény. Použití obrázku 
místo geometrických zářičů se nazývá osvětlení obrázkem (Image-
Based Lighting, IBL). 

3. BACKGROUND MAPPING: podobná sada parametrů jako Environment 
Mapping one, ale obrázek nebo barva bude pouze zobrazena na 
pozadí scény, bez jejího příspěvku k osvětlení scény. Tato funkce se 
používá pro zákresy do reálných fotografií. 

4. REFLECTION MAPPING: obrázek nebo barva definovaná v tomto oddílu 
bude přidána k reflexím perfektně odrazivých objetů  (většinou 
skla) ma scéně a stejně jako Background Mapping nebude použita 
jako světelný zdroj. 
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Pracovní oblast je místo, 
kde se odehrávají různé 
akce. V jejích záložkách je 
zobrazen renderovaný 
obrázek, můžete zde z jed-
noho (vy)renderovaného 
obrázku získat množství 
obměn pomocí funkce Layer 
Blending, můžete zde 
prohlížet scénu pomocí 
realtim pohledu a nakonec 
Network Manager vám 
poskytne kontrolu nad 
síťovým renderingem. 

PRACOVNÍ OBLAST 

Záložka Context seskupuje všechny funkce, které se vztahují k renderovanému obrázku. Zde můžete 
provádět operace s framebufferem nebo zde můžete řídit algoritmus tonálního mapování a náhledové okno 
vám přitom poskytne okamžitou odezvu při změně jakéhokoliv parametru. 

CONTEXT 

 1 

 3 

 2 

 4 

1. FRAMEBUFFER OPERATIONS: operace s aktuálním obsahem framebufferu. 

2. RENDER PREVIEW: náhled ukazuje řešení, ke kterému aktuální render konverguje. 

3. TONEMAPPING CONTROLS: parametry tonálního mapování, postprocesu a pokročilých čočkových efektů. 

4. FRAMEBUFFER: renedrovaný obrázek. 

Framebuffer a náhled 

Tato ústřední část pracovního prostředí zobrazuje renedrovaný obrázek. Zobazení probíhá tak, že obsah 
framebufferu je zpracován algoritmem tonálního mapování, který vygeneruje výsledný RGB obrázek. Pixely 
tohoto RGB obrázku jsou získány sběrem vzorků, které jsou filtrovány zvoleným algoritmem antialiasingu. 
Čím déle se obrázek počítá, tím vyšší počet vzorků bude shromážděn v každém pixelu a tím nižší bude ve 
výsledném obrázku úroveň šumu.  

Menší náhledový obrázek pracuje zcela stejným způsobem, ale protože je menší než aktuální framebuffer, 
lze v každém jeho pixelu získat více vzorků a tudíž se bude čistit od šumu mnohem rychleji. Sledujte náhle-
dový obrázek, abyste věděli, k jakému řešení aktuální render konverguje, protože za určitou dobu budou oba 
tyto obrázky naprosto shodné.  
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Tonální mapování 

1. TONEMAPPING CONTROL: algoritmus tonálního mapování transformuje HDR vzorky ve framebufferu pomocí 
Operatoru do RGB barev, které jsou zobrazitelné na počítačové obrazovce. V této záložce můžete pomocí 
ovládacích prvků řídit takové parametry převodu, jako je expozice obrázku, gamma korekce atd...  

2. POST EFFECTS: funkce v této záložce vám umožní aplikovat určité postprocesingové efekty jako je korekce 
barev, barevná teplota a antialiasingový filtr. 

3. LENS ABERRATION CONTROL: simulace čočkových jevů, jako vinětace, odlesk (glare), záře (bloom) a difrakce. 

4. RESET TONEMAPPING: zruší změny a vrátí nastavení tonálního mapování do výchozího stavu. 

5. SYNCHRONIZE THE FRAMEBUFFER: aktualizuje framebuffer podle současného nastavení. Náhledový obrázek se 
po každé změně aktualizuje automaticky, ale pokud chcete tyto změny promítnout do hlavního frame-
bufferu, musíte kliknout na toto tlačítko.  

6. TOGGLE INFO TAG: pokud je toto tlačítko stisknuto, bude na horní a dolní okraj obrázku přidán malý infor-
mační řádek s  informacemi o nastavení renderu, který tento obrázek vygeneroval. 

 1 

 2 

 3 

 4 

 5 
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Operace s framebufferem 

1. LOAD FRAMEBUFFER: přepíše aktuální obsah framebufferu dříve vygenerovaným souborem DSI.  

2. MERGE FRAMEBUFFER: kombinuje obsah aktuálního framebufferu dříve vygenerovaným souborem .DSI. 
Předpokládá se, že soubor pochází z té samé scény a sloučení je možné pouze tehdy, když slučované ob-
sahy mají stejné rozlišení a nastavení super-samplingu. Výsledný framebuffer pak bude mít méně šumu 
než každý ze zdrojových .DSI souborů. Tento nástroj pro slučování používejte pro vytvoření finálního 
obrázku, pokud několik různých počítačů počítá ten samý obrázek. 

3. SAVE DSI FILE: uloží obsah aktuálního framebufferu do souboru .DSI bez jakékoliv ztráty kvality. 

4. SAVE RGB8 IMAGE: na framebuffer aplikuje aktuální nastavení tonálního mapování a vygeneruje RGB 
obrázek s 8bitovými kanály a zapíše jej na disk v libovolném z podporovaných formátů.  

5. SAVE RGB16 IMAGE: na framebuffer aplikuje aktuální nastavení tonálního mapování a vygeneruje RGB 
obrázek s 61bitovými kanály a zapíše jej na disk v libovolném z podporovaných formátů.  

6. SAVE RGB32 IMAGE: na framebuffer aplikuje aktuální nastavení tonálního mapování a vygeneruje RGB 
obrázek s 32bitovými kanály a zapíše jej na disk v libovolném z podporovaných formátů.   

7. CLEAR THE CURRENT FRAMEBUFFER: vymaže aktuální framebuffer. 

 1  2  3  4  5  6  7 
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LAYER BLENDING - MÍSENÍ VRSTEV 

Layer Blending je funkce, která vám umožní generovat libovolné množství obrázků z jednoho jediného ren-
deru. Když vytvoříte scénu, můžete rozdělit zářiče do vrstev pomocí jejich objektových vlastností. Panel 
Layer Blending vám pak umožní řídit způsob, jakým jsou příspěvky těchto vrstev kombinovány do osvětlení 
výsledného obrázku. Vrstvy můžete zapínat, vypínat, měnit jejich jejich intenzitu a dokonce i RGB odstín. 

1. NÁSTROJOVÁ PALETA: import a export vašeho nastavení a tvorba klíčových snímků, které definují nastavení 
funkce Layer Blending.  

2. NÁHLED VYBRANÉHO SNÍMKU. 

3. ČASOVÁ OSA. 

4. VRSTVY: tento seznam zobrazuje všech 10 vrstev bez ohledu na to, zda jsou či nejsou využity. Počet sku-
tečně využitých vrstev závisí na tom, do kolika vrstev vložíte světelné zářiče. Každá z vrstev vám umožní 
zapnout a vypnout zářič, který je k ní připojený a také zde můžete měnit jeho výkon a RGB odstín. To vše 
lze provádět v průběhu výpočtu obrázku a dokonce i po ukončení výpočtu. 

 1 

 3 

 2 

 4 

REALTIME POHLED 

START: zapne realtime pohled. 

STOP: vypne realtime pohled. 

FETCH: zkopíruje parametry aktuálně vybrané kamery 
v seznamu kamer do kamery realtime pohledu. Tuto 
funkci použijte pro rychlé zobrazení některé z před-
nastavených kamer. 

HOLD: zkopíruje polohu a natočení aktuální kamery 
realtime pohledu do kamery, která je vybrána v 
seznamu kamer. Tuto funkci použijte pro modifikaci 
přednastavených kamer ve scéně a pro generování 
nových pohledů. 

FOCUS: zobrazí ohniskovou rovinu a ohniskovou 
vzdálenost. 

V realtime pohledu si můžete prohlížet aktuální scénu v reálném čase a můžete zde také vybírat alternativní 
pohledy pro renderování. Pohled využívá pro pohyb ve scéně svoji vlastní kameru, přednastavené kamery ve 
scéně proto nebudou nijak modifikovány, pokud nepoužijete funkci Hold / Fetch.  
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Penel Network se používá pro distribuci a správu renedrovacích úloh na různé počítači v rámci jedné lokální 
sítě (LAN). Render můžete urychlit tak, že přidělíet různým počítačům různé snímky nebo tak, že jeden 
obrázek bude počítán několika počítači a poté všechny výsledky z těchto počítačů sloučíte do jednoho 
výsledku s nižším sumem.  

SPRÁVCE SÍTĚ 

1. NÁSTROJOVÁ PALETA: odtud můžete spustit nebo zastavit Network Manager. Pomocí tlačítek Load a Save 
můžete ukládat typická schémata úloh a nahrávat je pro opětovné použití. 

2. HISTORIE ZPRÁV. 

3. RYCHLÝ VZDÁLENÝ NÁHLED: tato oblast zobrazuje obrázek, renderovaný vybraným uzlem. 

4. SÍŤOVÉ UZLY V LAN: v tomto okně můžete přidávat počítače, které chcete využít pro renderování. Pro auto-
matické prohledání sítě LAN použijte tlačítko Detect. 

5. SÍŤOVÉ ÚLOHY: v tomto okně můžete distribuovat renderovací úlohy mezi dostupné uzly, omezovat čas 
přidělený každému z uzlů a nastavovat výstupní soubory.  

6. SÍŤOVÝ MONITOR: tento seznam zobrazuje v reálném čase informace a aktuálním stavu úloh a uzlů. 

 1 

 3 

 4  5  6 

 2 

Pomocí vlastností objektů můžete změnit způsob, jakým jsou objekty zobrazovány v realtime pohledu, stan-
dardně je jejich vzhled aprocimací barvy materiálu se zobrazenými UV souřadnicemi, takže můžete snadno 
odhalit případné geometrické nebo mapovací chyby. 
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 ZDROJE 

Tato příručka pokryla základy, které musíte znát, pokud chcete začít 
používat fryrender. Další informace najdete na webu fryrenderu 
společně s dokumentací, tutoriály a bezplatnými materiály, ze kterých 
se můžete učit. Doporučujeme vám, abyste se zaregistrovali také na 
diskusním fóru fryrenderu, kde můžete debatovat v rámci přátelské a 
nápomocné komunity uživatelů a kde můžete předvádět svá díla a řešit 
problémy s profesionálními uživateli. 

fryrender můžete zakoupit v internetovém obchodě www.3dshop.cz  

 

Happy frying! 

Feversoft Team 




